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COPYRIGHT NOTICE 

Copyright © 2016 by Align Technology, Inc. All rights reserved. 

English language version.  Updated September 8, 2016. ClinCheck Pro 5.0 version 5.0.0.379 NA 

No part of this manual may be reproduced, photocopied, stored in a retrieval system, or 
transmitted in any manner (electronic or mechanical) for any purpose other than the customer’s 
normal usage, without the prior written permission of Align Technology, Inc. 

TRADEMARKS 

INVISALIGN and CLINCHECK are trademarks and/or service marks of Align Technology, Inc. 
or one of its subsidiaries or affiliated companies and may be registered in the U.S. and/or other 
countries. All other trademarks are the property of their respective owners. 

USA CORPORATE HEADQUARTERS 

Align Technology, Inc. 
2560 Orchard Parkway 
San Jose, California 95131, USA 
Tel: +1 (408) 470-1000 

INTERNATIONAL HEADQUARTERS 
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Arlandaweg 161 
1043 HS Amsterdam  
Tel: +31 (0) 20-586-3600 

 

EU AUTHORIZED REPRESENTATIVE 

Emergo Europe 
Molenstaat 15 
2513 BH, The Hague 
The Netherlands 

 

CUSTOMER SUPPORT 

For questions, please contact your local Customer Support.Contact details are available on 
your Invisalign Doctor Site under the Support tab. 
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What Is ClinCheck Pro 5.0 Software? 

The ClinCheck software is a proprietary 3D computer application (electronic prescription) 
for depicting, viewing, editing, monitoring and approving an orthodontic treatment plan, 
including a virtual representation of the patient’s expected tooth movement from the 
beginning through final stage of their Invisalign case in a virtual three dimensional 
model.  

ClinCheck is designed to be available on the treating doctor’s computer and is 
immediately launched by the system when the user clicks on the ClinCheck file. The 
software provides a computerized approximation of desired tooth movement for a 
specific patient and the results are simulated based on the approved ClinCheck 
treatment plan. The ClinCheck treatment plans includes the ClinCheck model with 
options such as placement of attachments or ridges and Interproximal Reduction (IPR) if 
required by the treatment plan. The doctor is requested to review the ClinCheck 
treatment plans thoroughly. The doctor may make changes or modifications via the 
ClinCheck software prior to approving the final ClinCheck treatment plan. The doctor’s 
approval of the customized ClinCheck treatment plan is considered a prescription and 
constitutes final authorization for Align to manufacture the aligners.  

Note: All names used in this document are not intended to reflect actual persons. Any 
similarity to an actual person is merely coincidental. 

Note: Many of the examples shown in this guide have been exaggerated for instruction 
purposes and may not reflect actual clinical conditions. For example, a tooth may be 
displayed initially hyper-rotated to show the effect of the correction tool.  

Indications 

The Invisalign®  System is indicated for the alignment of teeth during orthodontic 
treatment of malocclusion. 
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How this Document is Organized 

Section I, User Interface Overview, orients you to the new ClinCheck 5.0 user interface,  
explains the major divisons of the screen, and shows how to set system preferences.  

Section, II, Reviewing Treatment Plans, explains how you can change the 3D model 
view, use the display tools, view animations, export movies and still images, and 
approve the treatment plan. 

Section III, Creating New Treatment Plans, describes the process by which you create a 
new plan and submit it to your Invisalign team. It explains how to modify tooth positions, 
manage attachments and cuts, adjust IPR and spacing, and manage occlusal contact.  

Section IV, Installation and Operation, shows system requirements and installation 
procedure as well as information about using the mouse and keyboard, keyboard 
shortcuts and working offline.  

New Features in ClinCheck Pro 5.0 Software 

ClinCheck Pro 5.0 software has new features and capabilities that provide a more 
intuitive and visually pleasing user interface (UI) and help you work faster and more 
accurately. This section provides an overview of the most important new UI features 
along with references to more detailed explanations and instructions.  

Multiple Treatment Plans  

ClinCheck Pro 5.0 software employs a tab system that allows you to open multiple 
treatment plans and even view them side by side for comparison. When you create a 
new treatment plan to make changes to the plan you are reviewing, you can use this 
capability to compare your new treatment plan to the treatment plan submitted by Align 
as shown below.  
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Enhanced Model Rendering 

In addition to the Classic representative used in previous versions, ClinCheck Pro 5.0 
software has added two more realistic representations of the 3D model, which are called 
Natural and Vivid.  

   
Vivid Natural  Classic 

Anteroposterior Correction Visualization (A-P Vis) 

ClinCheck Pro 5.0 software now supports Anteroposterior Correction Visualization, 
which is helpful when dealing with a number of bite problems.  It allows you to see the 
bite correction either at the beginning or end of treatment (simulating a surgical 
correction) as well as correction spread throughout the treatment plan (simulating 
interarch elastics). When A-P visualization is enabled, a gray bar appears in the center 
of the Stage indicator as shown in the example below.  

  

A-P Correction Visualization,  
Treatment Start 

A-P Correction Visualization,  
Treatment Treatment Complete 

ClinCheck Pro 5.0 Keyboard Shortcuts (Hotkeys)  

ClinCheck Pro 5.0 software for the Windows operating system supports new keyboard 
shortcuts for the most commonly used operations. Shortcut information is displayed in 
parentheses in menu items and in tooltips as shown in the figures below.  

  
Hotkey reference in tooltip Hotkey reference in menu items 
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 USER INTERFACE OVERVIEW 

The ClinCheck user interface has been completely redesigned for ClinCheck Pro 5.0 
software to provide a more intuitive, customizable user experience. This section 
describes the organization and placement of the buttons, menus, and controls that allow 
you to interact with ClinCheck Pro 5.0 software. It also provides instructions for getting 
started, in particular, opening treatment plans, and using the 3D display.  

A typical ClinCheck Pro 5.0 screen is shown below. Note the following logical divisions: 

• Header – Contains four buttons: Back to Home (left arrow), ClinCheck Pro (page 10), 
Other Actions (page 49) and Submit Changes (page 64). 

• 3D display panel – Allows you to examine in three dimensions the current plan as 
well as any modified plans that you create (page 16).   

• Information panel – Provides a mechanism for exchanging information between Align 
and the doctor (page 20). 
 

 

ClinCheck Pro 5.0 software screen showing logical divisions  
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1. The Main Menu 

The ClinCheck Pro 5.0 software Main menu allows you to open and print treatment 
plans, set display and movie parameters, access help, and exit the ClinCheck program. 

 

To view the Main menu, mouse over or 
click the ClinCheck Pro button. A 
dropdown menu appears as shown at 
left with four choices: 

• File and Help display the correspond-
ing submenu, described in the follow-
ing subsections.  

• Settings brings up the Settings panel 
(see page 11). 

• Exit closes the ClinCheck software.  

 File Operations 

 

 

 

The File submenu enables you to perform 
the following tasks by clicking the item or 
using the keyboard shortcut, if any, shown 
in parentheses.  

• Open displays a dialog box that allows 
you to select a treatment plan (Ctrl-O). 

• Print (Ctrl-P) opens the Print Dialog box, 
shown at left, which allows you to 
choose which parts of the treatment plan 
you wish to print.  

• Print Setup opens the Windows Page 
Setup dialog box.  

• Recent Items allows you to open a treat-
ment plan that you recently accessed.  
Click on or mouse over Recent Items to 
see the available plans. 
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 Help Functions 

 

 

The Help submenu provides access to 
the following information: 

• What’s New displays a summary of 
the new features in the 
ClinCheck Pro 5.0 software.  

• Getting Started Guide displays a 
short set of instructions for new us-
ers. 

• About ClinCheck Pro provides key 
information as shown at left.  It also 
includes a link to contact customer 
support or clinical support at Align 
Technology.  

2. The Settings Panel 

 

The Settings panel has two tabs, 
Display and Movie. Each tab has 
Cancel and OK buttons at bottom right.  
You must select one of these two 
options to exit the current tab.  

• The Display tab (shown at left) is 
open by default when you select 
ClinCheck Pro   Settings.   

Each of the three highlighted sub-
sections – Display, Interface and 3D 
Modification Preferences – is de-
scribed in a separate subsection be-
low. 

• The Movie tab is described on page 
15. 
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 Display Settings 

 

You can set the following display parameters:  

• Font size –  Move the slide to select the 
desired font size for the display. 

• Performance –  Factory-set to Auto.   

• Color Scheme – Select Classic, Natural 
(default) or Vivid. See descriptions below.  

• Colors – Customize colors for background, 
teeth, attachments, numbers and occlu-
sion.   

• Show Patient Info – Check the box to 
show (default) patient information.  
Uncheck the box to hide the information to 
ensure privacy when reviewing the treat-
ment plan in public. 

 

Color Scheme Options 

Option Description Example 

Vivid Teeth and gingiva are shown 
with intense colors.  

 

Natural 
(default) 

Life-like representation of the 
colors occurring in human 
dentition.  

 

Classic 
Same as the color scheme 
used in previous versions of 
the ClinCheck Pro software. 
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 Interface Settings 

 

You can set the following interface 
parameters:  

• Rotation –  Sets the effect of cursor move-
ment on the 3D model. Options are Free-
form (default), Simple or Precise. See de-
scriptions below.  

• Default Zoom – Sets the initial view of the 
model. Options are Small, Medium (de-
fault), Large, or XL.  

Rotation Options 

ClinCheck Pro 5.0 software provides three modes of rotation. The examples show the 
effect of cursor drag movement in the direction of the arrow starting from the anterior 
view. Note that Precise mode makes it easier to control model position depending on 
whether you click and drag on the model or outside the model.  

Mode Description Effect of Movement Shown 
by Arrow 

Reference Anterior view 

 

Free-form 
(default) Drag in any direction to rotate the model.  
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Simple 

Clicking and dragging restricts the rotation 
to either the horizontal or vertical plane, 
even if the cursor moves diagonally. To 
change the orientation, release and click 
again.  

 

 

Precise 

Clicking on the model and dragging 
rotates the model in the direction of the 
cursor movement, using the click point as 
the rotational axis.  

 

 

Clicking outside the model and dragging 
vertically tilts the model.    

 

Clicking outside the model and dragging 
horizontally rotates the model around the 
click point.  
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 3D Modification Preferences 

 

You can set the following 3D 
Modification Preferences:  

• Allow non-recommended IPR val-
ues (Off by default) Enable IPR 
values 0.1 and 0.6 and higher.  

• Include A-P correction in tooth 
movement measurements (Off by 
default). Add A-P movements in 
the tooth movement table.    

 Movie Information 

 

 

The Movie screen allows you to 
input doctor and patient contact 
information that is included when 
you send a ClinCheck Pro 5.0 
software movie to your patient.  

• To access the Movie screen, 
click on the Movie tab.  

• Use the Display doctor and Dis-
play Patient checkboxes to ena-
ble the respective information to 
be included in exported movies 
(see page 48). 

• Clicking on the Display Patient 
checkbox results in the dialog 
box shown below left. Click OK to 
enable the display of the patient’s 
name.  
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3. The 3D Display Panel 

The 3D Display panel of ClinCheck Pro 5.0 software contains a variety of tools and 
controls to help you clearly understand the proposed treatment plan and evaluate 
whether the plan achieves your clinical goals. Each section of the panel is described in a 
separate subsection below, starting with the Tools Menu and moving clockwise.  
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 Tools Menu 

The Tools Menu has two functions: 1) provide access to the full range of 
ClinCheck Pro 5.0 software tools, and 2) customize the Quick Access toolbar.  

 

• To display the Tools menu, click 
the Tools button in the upper left 
corner of the Display panel. The 
Tools dropdown menu appears 
as shown at left.  

• To hide the dropdown menu, 
click the Tools button again.  

• To view tool tips in the 
dropdown, pause the cursor 
over any tool. 

All of the ClinCheck tools are 
shown in the dropdown, whether or 
not they are active for the case 
under review. Note that this list is 
“live,” meaning that you can click 
any tool to activate the tool’s 
function (see page 34 ff for 
information about individual tools).  

 Timeline Tab 

The Timeline tab displays a history of the treatment plan for this patient. You can access 
previous plans by clicking on the plan name on the right.  
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 Treatment Plan Tabs 

ClinCheck Pro 5.0 software uses a tab system to allow you to navigate between open 
treatment plans.  The figure below shows three tabs for the same patient.   

 

 Quick Access Toolbar 

ClinCheck Pro 5.0 software allows you to quickly and easily select tools from the Quick 
Access toolbar. You can activate any tool by clicking the icon in the Tool bar. 

Tool States 

Tools can be in one of three states: 

• Active – The tool function is enabled.  For example, when IPR is active, the 3D 
model displays the IPR values.  

• Inactive – The tool function is disabled.  For example, when GRID is inactive, the grid 
is not displayed. 

• Unavailable – The tool function is not relevant to this treatment plan. For example, 
TEEN is unavailable for adult patients with Invisalign Full.   

STATE  Active Inactive Unavailable 

Quick Access 
toolbar 

   

Tools menu 
   

The diagram below shows the default set of tools in ClinCheck Pro 5.0 software when 
first installed.  You can customize the toolbar to show the tools that you use most often 
and hide the others as described in the following subsection. For descriptions of 
individual tools, see page 35. 
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Customizing the Quick Access Toolbar 

You can customize the ClinCheck Quick Tools Bar by adding and removing tools.   

 

• To begin the customization pro-
cess, click Customize Toolbar on 
the dropdown menu.   

• Plus and minus signs next to the 
individual tools indicate the tool 
status and options:  

Plus = Hidden. Click to add  
Minus = Visible. Click to remove. 

• When you have finished customi-
zation, click Exit Customize.  

 Stage Indicator 

The Stage indicator shows the treatment stage that is currently displayed on the 3D 
model (each treatment stage corresponds to a specific aligner set). You can click on any 
segment to display the model for that stage and you can also drag the indicator slider to 
the desired stage (see page 45 for more information about animation playback).  

 

 Animation Toolbar 

ClinCheck Pro 5.0 software has playback capabilities that allow you to see an anmiation 
of the tooth movements as they appear at each stage of the Align treatment plan (see 
page 45 for more information about animation playback). 
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4. The Information Panel 

 

 Sizing the Information Panel 

The Collapse and Expand buttons allow you to control the size of the Information panel.  
You can also customize the relative sizing of the 3D Display and Information Panel by 
clicking and holding on the boundary between the two panels and dragging to the 
desired size.  

 

Normal Collapsed 

Expanded Custom 
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 Comments Tab 

The Comments tab provides a communication mechanism between the practitioner and 
Align. It is divided into two pages, My Comments and Comments History. The slider at 
the top of the tab toggles between the pages. 

Comments History 

This page contains comments from Align about the current treatment plan. Because this 
page captures a record of treatment history, ClinCheck Pro 5.0 software prevents you 
from altering this page. 

When you first open a new ClinCheck plan, please review the comments from Align at 
the top of the Comments History.  
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My Comments 

 

The top field contains comments that you add to request desired changes and save 
screen captures with instructions.  

The bottom field of this page contains comments that are automatically generated by the 
ClinCheck Pro 5.0 software when using 3D controls. For example, when you adjust a 
tooth, ClinCheck Pro 5.0 software generates the comment “Tooth X adjusted.” 

Screen Capture  

The Add Screen Capture button captures the current 3D model display.  When you click 
on this button, a small camera icon appears in the doctor’s comments area.  Clicking on 
the camera icon will rotate the model to the view you saw when the comment was 
written, helping the technician to better understand your comments.  
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 Treatment Tab 

This tab has two pages, Treatment Overview and Movement Assessment, which can be 
selected by clicking on the underlined text. Use the scroll bar to see all of the information 
in the pages of the Treatment tab.  

Treatment Overview  

This page shows estimated treatment time, the upper and lower aligner numbers of the 
active stage, IPR requirements and aligner features.  
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Movement Assessment  

This page identifies teeth that have large movements (blue and black as shown in the 
legend below) and shows the amount of movement triggering the assessment and the 
range of the assessment. Missing teeth are marked with an X. 
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Staging Tab  

The Staging tab provides a visual timeline of tooth movement in each of the stages of 
the Align treatment plan. It also shows when IPR has to be performed and when 
attachments have to be bonded and removed for each tooth. This information is very 
useful when scheduling office visits for your patient. 
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 Photos Tab 

The Photos tab contains patient photographs submitted by the doctor. It is important that 
you obtain all consents from patient required by law before submitting photographs to 
Align Technology.  

 

Dentition images are linked to the corresponding ClinCheck view. For example, clicking 
on the upper jaw photo shown at left below brings up the upper jaw view of the 3D model 
shown on the right.  
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 REVIEWING TREATMENT PLANS 

ClinCheck Pro 5.0 software has a full range of features that allow you to review the 
treatment plan developed by your Align team, including: 

• Setting Up the View 

• Using Tools 

• Viewing Treatment Animations 

• Sharing Information 

• Finishing Your Evaluation 

5. Setting Up the View  

ClinCheck Pro 5.0 software gives you a wide range of control of the 3D model. 
Specifically, you can select a view mode, change the view, change the model size and 
perform other movements on the model.  

 View Mode 

ClinCheck Pro 5.0 software offers five different modes for the 3D panel.  To select the 
mode, click on the Views button on the Quick Access toolbar or the Tools dropdown 
menu as shown below. 
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3D View Modes 

Mode Shortcut: 
Ctrl+Shift Description 3D Display 

Single S Single 3D view of 
the current plan.  

 

Occlusal O 
Maxillary and 
mandibular 
occlusal views.  

 

Dual D 

Initial and final 
stages of the 
current treatment 
plan. 

 

Composite C 

Right and left 
buccal, anterior, 
and maxillary and 
mandibular 
occlusal views. 

 

Compare 
Plans A 

Compare two or 
more different 
plans, for 
example, Initial 
plan and new 
Additional 
Aligners plan  
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 Primary Views 

ClinCheck Pro 5.0 software gives you five primary model views from which to choose. 
You select the desired view using the Primary View toolbar, which is located below the 
Quick Tools bar.  The Primary View menu is visible whenever the cursor is inside the 3D 
model area. 

 

The buttons on the Primary View toolbar have the following effect on the model view. 

 

The anterior and buccal views can be modified to show only one jaw using the upper 
and lower jaw buttons. These two buttons are toggles: clicking once activates the single-
jaw view and clicking again restores the both-jaws view as shown below.  
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Native view 
  

   

   

 Secondary Views 

ClinCheck Pro 5.0 software also provides a set of secondary views. To access the 
Secondary Views submenu, right click anywhere in the 3D model area, then mouse over 
Secondary View to display the submenu. The secondary views are summarized in the 
graphic below.  

 
Secondary Views Menu 
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 Side-by-Side/Dual View 

ClinCheck Pro 5.0 software has the capability to show either 1) a single stage of the 
treatment plan, or 2) the initial and final stages side by side. Each mode has a button 
that returns the view to the other mode.  

 
Single View 
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Side-by-side view 

 Model Size 

ClinCheck Pro 5.0 software allows you to vary the zoom factor of the model using the 
Zoom slider shown below. You can also zoom by pressing the Control key and clicking 
and dragging with the mouse. 

You set the default zoom factor – Small, Medium, Large and XL – using the Settings 
panel (see page 12). 
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3D Display Zoom Factors 

Zoom Factor 3D Display 

Minimum 

 

Maximum 

 

 3D Model Manipulations  

ClinCheck Pro 5.0 software allows you to use cursor movements to rotate and translate 
the 3D model as needed for your analysis. The cursor function is controlled by the 
Cursor mode button located in the lower right corner of the 3D Display panel. The button 
works as a toggle between the two modes and the current mode is indicated as shown 
below. 
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Rotate 

To rotate the model, first choose the Rotate (default) cursor mode. Then click and hold 
anywhere in the 3D Display panel, move the cursor to achieve the desired rotation and 
release the cursor. You can change the effect of the cursor movement – Free-Form, 
Simple or Precise – using the Settings panel (see page 13).   

Translate 

To translate the model, first chose the Translate cursor mode. Then click and hold 
anywhere in the 3D Display panel, move the cursor to move the model to the desired 
screen location and release the cursor.  

Shortcuts 

When in Rotate mode, you can momentarily switch to Translate mode by pressing the 
Shift key and clicking and dragging with the mouse. You can also zoom by pressing the 
Control key and clicking and dragging with the mouse. 

6. Setting the Occlusal Plane Inclination 

ClinCheck Pro 5.0 software provides the ability to match the 3D model orientation to the 
orientation of the patient’s teeth using the Occlusal Plane Inclination tool, which is 
located on the Tools Dropdown menu as shown below. The occlusal plane inclination 
that you set is sent to Align for the current order.  

 

When you activate the View Angle, the 3D Display panel displays horizontal and vertical 
axis and controls as shown below.  
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To change either angle, click and hold the indicator and drag to the desired angle 
between -30 and +30 degrees.  

To set the angle, click the Apply button.  The Anterior, Left Buccal and Right Buccal 
views will now be displayed at this angle.  The value of the occlusal plane inclincation is 
also stored with the current treatment plan for use by Align technicians.   

To return to the original view (0 degrees), click Reset and Apply.   

7. Using Tools 

ClinCheck Pro 5.0 software provides a rich set of tools that allow you to fine-tune the 
visual information shown for the 3D model. You can activate any tool by clicking the icon 
in the Tools dropdown menu. In addition, you can activate commonly used tools using 
the Quick Tools bar. See page 19 for information about customizing the Quick Tools bar. 
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 Anteroposterior Correction Visualization (AP-Vis) Tool 

 

The A-P Vis button allows you to choose one of four options from the  
A-P Vis dropdown submenu. 

 

Each option changes the Stage indicator as shown below. The middle 
set of gray dashes show the stages with anteroposterior corrections.  

 

Visualization defaults: 

• For surgical simulation, visualization at the end of treatment unless 
requested at the beginning of treatment when submitting the Rx 
Form. 

• For correction with Class II or Class III elastics, visualization through-
out the treatment, to simulate the simultaneous A-P and dental cor-
rections. Please note that the number of stages needed to correct the 
A-P discrepancy doesn’t necessarily correlate to the number of 
stages needed to align and level the teeth. 
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 Attachments Tool 

 
Shift-A 

 

The Attachments tool displays or hides the attachments. Mouse over 
any attachment to see the attachment type. 

 
Attachments displayed 

 
Tooltip on mouse over 

 Bolton Analysis Tool 

 

The Bolton Analysis tool provides reference information about tooth size 
discrepancy that is useful for planning how to address tooth inter-
digitation and arch coordination. Note that the analysis is not 
automatically integrated into the treatment planning setup protocol but is 
provided for your assessment. 
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 Export Tool 

 

The Export tool allows you to share treatment plans with your patients, 
export movies and screenshots and export STL files (see page 46). 

 Grid Tool 

  

 
Shift-G 

The Grid tool toggles the display of a measurement grid.  When the grid 
is on, the view is flattened to facilitate accurate measurements 

 
Grid Off 

 
Grid On 

 IPR Tool 

 
Shift-I 

 

The IPR tool toggles the display of IPR values. When IPR values are 
displayed, you can mouse over the triangle to see more information.   

 
IPR Displayed 

 
Tooltip 

 

  



ClinCheck® Pro 5.0 User’s Guide 

Part No. D16765 Page 39 

IPR Colors 

Color Example Meaning 

White 
 

IPR to be performed in future stages.  

Yellow 
 

IPR to be performed in the current stage.  

Gray 
 

IPR that should have been performed in a previous stage.  

 Occlusal Contacts Tool 

 
Shift-C 

 

The Occlusal Contacts Tool has two functions, which are selected from 
the dropdown menu shown below.  

 

When you are reviewing the Align treatment plan, only Show Occlusal 
Contacts is available. Click on this item to toggle the display of occlusal 
contract in the initial and final stages only. See below for a typical 
display.  

The red up and down arrows indicate the presence of heavy occlusal 
contacts. When you create a new treatment plan, Resolve Heavy 
Occlusal Contacts is available.  See page 63 for more information about 
using this option. 
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 Occlusal Plane Inclination Tool 

 

The Occlusal Plane Inclination tool is described in detail under Setting 
the Occlusal Plane Inclination on page 34. 

 

 Overcorrection Tool 

  
Shift-O 

 

The Overcorrection tool toggles the visualization of three additional 
stages as specified by the doctor. Movements prescribed in these 
stages are optional, for example, virtual c-chain to tighten contacts at the 
end of treatment. 

 
Off 

  
Additional overcorrection stages 

 

 Pontic Tool 

 
Shift-F 

 

The Pontic tool toggles between showing and hiding the pontics in the 
3D model.  

 
Show pontics 

 
Hide pontics 
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 Superimposition Tool 

 

 
Shift-S 

 

The Superimposition tool allows you to visualize the relative movements 
of teeth from one stage to another. The ClinCheck Pro 5.0 software 
superimposition functions shows tooth movements along the viewing 
axis, that is, forward or backward from the viewer’s perspective. The 
view is controlled by the two sliders shown below. The blue color is 
translucent, so white teeth movements behind blue teeth are visible. 

 

Guidelines for using the Superimposition tool:  

• Method 1: Set the bottom slider to the reference stage, then drag the 
top slider to the (later) evaluation stage. White teeth are moving to-
wards viewer. The translucent blue teeth are not visible, except for 
their edges, if applicable.  

• Method 2: Set the top slider to the reference stage and the bottom for 
the evaluation stage as shown on bottom right. Now the white teeth 
are moving away from viewer; the translucency allows you to see 
both and visualize the differences. 

• Vertical movements can also be managed in the same manner as 
horizontal movements to create the best visual superimposition to 
evaluate the movements. 
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White Teeth Moving toward the Viewer 

 
White Teeth Moving away from the Viewer 

 Teen Tool 

  

 
Shift-T 

 

The Teen tool controls the visibility of eruption features for pre-teen and 
teenage patients. 

 

Off 

 
On 
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 Tooth Movements Table Tool 

 

The Tooth Movements Table tool displays all the movements 
programmed for each tooth. Movement can be displayed based on the 
center of the crown or the virtual root apex by selecting the Tooth Basis 
buttons. When using 3D controls, the additional functionality of the Align, 
Doctor and Difference buttons supports detailed evaluations. 

  

 Tooth Movement Assessment (TMA) Tool 

 

The Tooth Movement Assessment (TMA) tool shows larger tooth 
movements that could be more difficult to achieve in the treatment.  Blue 
dots indicate moderate movements, while black dots show advanced 
movement. These assessments are also shown in the Treatment tab of 
the Information panel (see page 23). 

 

On 

 

Tooltip 
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 Tooth Numbering Tool 

 

 
Shift-N 

 

The NUM button toggles the display of tooth numbers on the 3D model. 
When pontics are displayed, they are marked with a P.   
 
To change the default numbering system – Universal, Palmer or Federa-
tion Dentaire Internationale – go to the clinical preferences section of the 
Invisalign Doctor Site 

 

Off 
 

On 

 View Tool 

 
Shift-V 

The View tool displays a gallery of primary views as shown below. For 
more information, see Setting Up the Display starting on page 27. 

 

 

  



ClinCheck® Pro 5.0 User’s Guide 

Part No. D16765 Page 45 

8. Viewing Treatment Animations 

You can play an animation of the ClinCheck treatment plan using the Animation Control 
Bar to show tooth movement from the initial stage to the final tooth position. 

A stage is a discrete step in a ClinCheck treatment plan to accomplish a specified tooth 
movement for one or both arches. Each stage of tooth movement corresponds to an 
aligner set that will be manufactured for your patient.  

One 3D model depicts the tooth position for each stage. Viewed in sequence, the series 
of images creates a 3D animation of tooth movement from beginning to end 

The functions of the buttons on the Animation Control Bar are shown below. 

 
Clicking on the Play/Pause button causes the animation to play from the current stage 
(as shown by the Stage indicator) to the final stage of the treatment.  

You can also view the movements step by step using the Step Backward and Step 
Forward buttons. Each click moves the animation one stage.   

You can go to a specific stage by grabbing and dragging the Stage slider or by clicking 
on the timeline. 

Note that the animation playback works with any display mode (see page 27).  
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9. Sharing Information  

ClinCheck Pro 5.0 software provides capabilities for sharing treatment plans, movies and 
still images with colleagues and patients using the Export button. You can also export 
the model information as a stereolithography file (STL format).   

Click on the Export button to display the dropdown menu shown below.  

 

 Sharing Treatment Plans 

To share Align 3D treatment plan with patients via email:  

• Choose Export Treatment Plan from the Export Menu. 

• Provide the necessary information: 

EMAIL TO: The patient’s email address.  Check the Copy Me box if you’d like to receive 
a copy. 

SHOW: Choose the information to be shared: Attachments, cuts, IPR/spaces, and 
pontics. 

INCLUDE OTHER INFORMATION: You can optionally include your contact information.  

You must check the box indicating that you have read the HIPAA warning statement. 
The statement is shown in the figure below.  
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 Exporting Screenshots 

 

To share a screenshot in PNG 
format: 

• Choose Screenshot from the 
Export Menu. A dialog box 
prompts you for the location to 
save the screenshot. 

When you click Save, the export 
process begins.  
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 Exporting Movies 

 

• Choose Movie from the Export 
Menu. A dialog box appears as 
shown. 

• Set the desired values: 

o View 

o Speed 

o Quality 

• Choose to display or hide the 
doctor information using the 
Show Doctor Info checkbox. For 
information on setting the doctor 
information, see page 15.  

• Choose to display custom infor-
mation using the Custom check-
box. You can enter up to 35 char-
acters in this field. 

 

 

• When you have finished setting 
values, click OK. A dialog box 
prompts you to save the movie in 
AVI format. 

• When you click Save, the export 
process begins.  
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 Exporting STL Files 

 

To export stereolithography (STL) 
files: 

• Choose STL from the Export 
Menu. 

• Read the Terms and Conditions 
in the dialog box as shown at 
left. 

• Select the INITIAL or FINAL 
stage of the treatment plan. 
The INITIAL option is always 
selected by default.  

• Click OK to save the STL file to 
your preferred file location.  

Only teeth and gingiva are exported 
to the STL file. Other objects which 
can be placed on teeth are not 
exported (such as Attachments, Bite 
Ramps, Power Arms, Precision 
Cuts). Virtual geometry, pontics, 
and IPR/space flags are also not 
included in STL files.  

10. Finishing Your Evaluation 

Once you have evaluated the plan against your clinical objectives, you have three 
options: 

• Approve the plan using the Approve button. This action initiates the manufacturing 
process for your aligners. If you later need to modify or cancel an aligner order, con-
tact Customer Care.  

• Cancel the case using the Other Actions  Cancel button as shown below.  

 

• Create a new plan with a different outcome and submit the plan to Align.  Section III 
below describes the process for creating a new plan.  
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 CREATING NEW PLANS 

11. Starting a New Plan 

To begin the process, click the Create New Plan button. The button is located at the top 
of the Information panel as shown below. 

 

The ClinCheck Pro 5.0 software creates a new tab as shown below.   
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 Modification (Mod) Tab 

The New Outcome tab contains a copy of the Align treatment plan, which forms the 
starting point for your modifications. The name is generated by prefixing “Mod” onto the 
name of the Align treatment plan as shown below. 

 

 Control Buttons 

These buttons allow you to Undo and Redo edits and to reset the outcome to the original 
Align treatment plan: 

• The Undo button reverses the previous action. 

• The Redo button restores the previous action 

• The Reset button allows you to reset some or all aspects of the modifications to the 
original state using the pop-up box shown below. 

 

 Compare with Original button  

When you mouse over the Compare with Original button, the 3D display changes from 
the current final position of the teeth to the initial position of the teeth to visually assess 
what is moving and how.  

Clicking the button creates a side-by-side display showing the Align plan on the left and 
your proposed outcome on the right as shown below. Toggling the Initial, ALIGN Final, 
and Doctor Final buttons under the models allows you to compare the initial 
malocclusion to the Align plan, the initial malocclusion to your new plan, and the Align 
plan to your new plan. 
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 3D Controls Toolbar 

These tools allow you to make adjustments that show the technicians your desired 
modifications to the Align treatment plan.  

The first four cells of the 3D Controls toolbar provide access to the four options as 
shown below. Each option is described in a separate subsection. 
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12. Modifying Tooth Positions 

The Tooth option presents a set of tools that give you precise control of tooth 
movements in a wide range of orientations. Click on the Tooth button at the top of the 3D 
Controls toolbar to display the menu shown below. Choose either Crown or Root  
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 Changing a Single Tooth 

 

• Select the desired tool from the 
Tooth options.  The selected tool 
is shaded as shown above for 
Rotation.  

• Select the tooth to be modified.  
The tooth turns white while the 
rest darken and a symbol ap-
pears indicating the selected op-
eration.  In the examples below, 
Rotation is selected. 

 

• Use the cursor to drag the tooth 
along the indicated axis.  

 

• You can also fine tune the move-
ment applied in very small incre-
ments by clicking on the arrows 
beside the selected icon on the 
toolbar as shown at left. The cur-
rent value of total movement ap-
plied is continuously updated as 
you click 

 Working with Multiple Teeth 

ClinCheck Pro 5.0 software allows you to select multiple teeth, which then form a set 
that receives the same modifications simultaneously. 

 

• Select the first tooth as described 
above. 

• While holding down Ctrl, click on 
additional teeth to add to the se-
lection.  Note that the modification 
handles move to the most recently 
selected tooth. Any modifications 
you make will be equally applied to 
both teeth.   

• Deselect any selected tooth by 
holding down Ctrl and clicking 
again. 
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 Making Complex Movements  

ClinCheck Pro 5.0 software provides a complex movements tool that allows you to make 
multi-axis movements without having to switch between individual tools: 

 

 

• Click on the Complex Movements tool.   

• Select the tooth (teeth) to be modified. 
The movement axes are displayed as 
shown at left.  

 

 

• Move the tooth in the desired direction 
by dragging the associated handle. It 
may be helpful to zoom in and rotate 
the view to access the desired handle. 
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 Locking Tooth Positions 

You have two options for locking a tooth position:  

• Make the tooth unmovable for the duration of the treatment.  This option usually ap-
plies to crowns, implants and ankylosed teeth. If the tooth had already been moved, 
making the tooth unmovable will reset the tooth to its original position. 

• Lock the tooth while modifying adjacent teeth. 

To select either option: 

• Right click on the tooth. A menu appears as shown. 

 

• Select the desired option. The tooth status is displayed upon mouseover as shown 
below for unmovable (left) and locked (right). Note that the cursor displays a red cir-
cled X when mousing over unmovable teeth.  

  

• To unlock the tooth, right click again. Choose the unlocking option. 
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13. Modifying the Posterior Arch  

ClinCheck Pro 5.0 software allows you to expand and contract the posterior arch. Click 
on the Arch button at the top of the 3D Controls toolbar to display the menu shown 
below.  

 

To modify the posterior arch: 

• Select Upper, Lower or Both. 

• Click on Expand or Contract. The arch 
moves in the selected direction with 
each click. 

 

 

  

Lower arch expansion, before and after (exaggerated to show effect)  
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14. Managing Attachments & Cuts 

ClinCheck Pro 5.0 software allows you to add and remove attachments and cuts. Click 
on the Attach & Cuts button at the top of the 3D Controls toolbar to display the menu 
shown below.  

 

 Adding Attachments & Cuts 

 

• Position the view for the best working angle.  

 

• Click and drag the attachment or cut to the de-
sired location, then release. 

 

 

• To identify attachments that you have added, 
mouse over any attachments.  Added attach-
ments display the message shown at left.  
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 Adjusting Attachments 

You can change the orientation and size of attachments that you add. Added precision 
cuts are fixed and cannot be adjusted.  

 

• To adjust the orientation of the attachment, click 
and drag the handles t 

 

 

• To adjust the size of the attachment, click on the 
attachment and choose the desired size.  

 

 Removing Attachments and Cuts 

There are two ways to remove attachments and cuts: 

  

• Method 1: Click on the attachment or 
cut, then click the “remove” message.  

 

• Method 2: Drag the attachment or the 
precision cut to the trash can.  
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15. Adjusting IPR and Spacing 

The 3D IPR tool provides three options for managing interproximal reduction as shown 
below. 

 

• Auto Adjust: ClinCheck automatically adds, removes, in-
creases and decreases IPR when teeth are adjusted. 

• Keep Current: The IPR prescriptions are maintained when 
teeth are adjusted. 

• No IPR: All existing IPR is removed and IPR will not be 
added when teeth are adjusted.  

 

 IPR Tool Visualization Options  

In the New Plan tab, the IPR tool has a dropdown menu in both the Tools dropdown 
menu and the Quick Tools bar. 

 
 

Tools dropdown Quick Tools button 

The dropdown menu options affect the display as shown below.  

   
Show +/x controls and  

IPR/Space flags Hide +/x controls onlyt Hide +/x controls and 
IPR/Space flags 



ClinCheck® Pro 5.0 User’s Guide 

Part No. D16765 Page 61 

 Adding IPR and Spacing 

 

To add IPR or spacing: 

• Click the green plus sign. 

• Select the option to add IPR or spacing.  

Note: If the “Add IPR” option is not visible, you 
have selected No IPR on the 3D Controls 
toolbar.  

 

Either a diamond-shaped (IPR) or rectangular 
(spacing) box appears as shown at left. 

• Adjust the values by clicking on the up and 
down arrows.  

 

 Removing IPR and Spaces 

 

To remove IPR or spacing:  

• Click the red X. 

• Select the option to remove IPR or Spacing. 
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 Adjusting IPR and Spacing Values 

 

To adjust IPR or spacing:  

• Click padlock to lock/unlock IPR value. When the 
IPR is unlocked, the software can auto-adjust it as 
you make tooth adjustments. When you manually 
adjust the IPR, the IPR will be locked automati-
cally. 

• To increase IPR value, click the arrow pointing up. 

• To decrease IPR value, click the arrow pointing 
down. 

• When IPR is above 0.5, the diamond shows a red 
border, which means the value is higher than rec-
ommended. If you want to add more than 0.5mm 
of IPR or less than 0.2mm of IPR, check “Allow 
non-recommended IPR values” in the Settings di-
alog (see page 15). 

Increasing, decreasing, locking and unlocking IPR is 
designed to provide a high level of control over the 
IPR prescription. 

 Displaying Tooth Numbers in Comments 

To display the number of a modified tooth in the comments area, Alt-Click the tooth. The 
tooth ID is copied to the Comments text box as shown. You can then add additional 
notes relevant to this tooth.  
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16. Changing Tooth Movements 

As described earlier, the Tooth Movements Table tool allows you to see the detailed 
movements of teeth for each aligner stage (see page 43).  When you are creating a new 
plan, you have the option to edit the values in the table. You can change the doctor or 
difference values; you cannot change the Align values.  

To change any value, click on the entry in the table.  The corresponding tool on the 3D 
Controls panel is highlighted as shown below.  Enter the new value either by typing a 
number or by clicking on the up and down arrows. 

 

17. Resolving Occlusal Contacts 

ClinCheck Pro 5.0 software allows you to view and hide occlusal contacts as described 
earlier on page 39. When you are creating a new plan, the Resolve Heavy Occlusal 
Contacts option is available as shown below. The red arrows indicate that heavy 
occlusal contacts are present and unresolved. Once they are resolved, the icon displays 
in blue.  

 

When you click on Resolve Heavy Occlusal Contacts, ClinCheck Pro 5.0 software 
automatically makes the necessary adjustments and creates a comment in the auto-
generated comments field of the My Comments page simliar to the one shown below.  
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 For better control, you can move the teeth and see the occlusal contacts change in real 
time. This method allows you to drive how heavy occusal contacts should be addressed, 
especially for anterior teeth. 

18. Submitting Changes 

When you are satisfied with the new plan, submit the changes using the Submit changes 
button shown below. 

 

This action initiates an automatic inspection of your new plan. ClinCheck Pro 5.0 
software generates an inspection report as shown below. For each issue, you must 
choose how you want Align to deal with this issue.  If you choose Leave As Is, the 
technicians will not change your modifications.  Choosing Fix For Me is a request to 
Align to find the best resolution consistent with your intended changes.  
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 INSTALLATION AND OPERATION 

This section presents system requirements, provides a step-by-step installation 
procedure, explains important information about data security, and describes the use of 
the mouse and keyboard. 

19. Keyboard Shortcuts 

No. Action Hotkey 

1.  Switch between treatment plan tabs Ctrl + Tab 

2.  File->Open Ctrl + O 

3.  File-> Print Ctrl + P 

4.  Patient timeline tab Shift + H 

5.  Attachments (ATTACH button) Shift + A 

6.  Numbers (NUM button) Shift + N 

7.  IPR (IPR button) Shift + I 

8.  Overcorrection (OVER button) Shift + O 

9.  Pontics (PONTIC button) Shift + P 

10.  Teen virtual geometry (TEEN button) Shift + T 

11.  Occlusal contacts (OCCLUS button) Shift + C 

12.  Grid (GRID button) Shift + G 

13.  Superimposition (SUPER button) Shift + S 

14.  View->Single Ctrl + Shift + S 

15.  View->Occlusal Ctrl + Shift + O 

16.  View->Dual Ctrl + Shift + D 

17.  View->Composite Ctrl + Shift + C 

18.  View->Compare plans Ctrl + Shift + A 

19.  UPPER button Ctrl + Shift + U 

20.  LOWER button Ctrl + Shift + L 
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21.  MAXIL button Ctrl + Shift +  

22.  RIGHT button Ctrl + Shift +  

23.  ANTER button Ctrl + Shift + F 

24.  LEFT button Ctrl + Shift +  

25.  MAND button Ctrl + Shift +  

26.  Create new doctor plan Ctrl + M 

27.  Reset doctor changes  Ctrl + R 

28.  Capture view  Ctrl + Shift + V 

29.  Go to previous treatment stage  Alt +  

30.  Go to next treatment stage  Alt +  

31.  Go to first treatment stage  Alt + Home  

32.  Go to last treatment stage Alt + End  

33.  Play/pause Alt + P 

20. Working Offline 

The primary way to gain access to ClinCheck treatment plans is online, on the 
Invisalign® Doctor Site, but you can also work offline (without an internet connection) 
with the Invisalign Patients Viewer. 

Note: When you work offline, you will not be able to submit changes or approve a 
ClinCheck treatment plan. 

When you open a ClinCheck Pro treatment plan online on the Invisalign Doctor Site, the 
treatment plan is saved locally on your computer in the Invisalign Patients Viewer. This 
viewer is installed on your desktop when you install the ClinCheck Pro software. The 
Invisalign Patients Viewer displays a list of ClinCheck Pro treatment plans stored on your 
computer – samples supplied by Align in addition to your treatment plans. 

• To open the Invisalign Patients Viewer from the desktop, double-click the Invisalign 
Patients Viewer icon on your computer’s desktop. 

• To open the Invisalign Patients Viewer from the Start menu on your computer, select 
All Programs, then Align, followed by ClinCheck Pro, and Invisalign Patients Viewer. 

• To open a treatment plan, click on the bar beneath the patient’s name. For sample 
treatment plans, click the bar beneath the treatment name. 
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21. Data Security 

Align takes great care in protecting the integrity and confidentiality of data from the 
moment it is collected. The treatment plan file is exchanged with the doctor in an Align-
proprietary format (ADF) using ClinCheck software, and the transmission of these files is 
encrypted. While it is the customer’s responsibility to protect access to their computing 
device as well as install appropriate malware protections, Align has the following 
recommendations for protecting devices/data: 

• Lock the screen of the device during periods of inactivity. 

• Sign out of your IDS account when finished.  

• Run up-to-date anti-virus software. 

• Use ClinCheck software only on private, firewalled networks. 

• Avoid the use of ClinCheck software on rooted or jailbroken devices (Note: Root-
ing/jailbreaking describe the acquisition of complete administrator rights on the de-
vice, allowing third-party programs to perform operations that were not originally pos-
sible). 

22. System Requirements 

In order to view ClinCheck treatment plans and return feedback to Align, you must have 
internet access and your computer should meet the minimum specifications below. 

 Minimum Hardware Requirements  
• Intel® Core™ i5, 4 GB RAM, 2 GB free disk space  

• Graphics card: Intel HD Graphics 

• Windows 7, 32 bit 

• Latest graphic card driver 

• Internet Explorer 11, Chrome, Firefox, Edge 

 Recommended Hardware  
• Intel® Core™ i7, 8 GB RAM, 2 GB free disk space  

• Graphics card: NVIDIA NVS 3100M or better Latest graphic card driver 

• Windows 7 or higher, 32 bit 

• Internet Explorer 11, Chrome, Firefox, Edge 
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 OS/Browser Support 

ClinCheck Pro 5.0 software supports the following combinations of browsers and 
operating systems. 

OS/Browser IE 11 Microsoft 
Edge 

Chrome 
(latest) 

FireFox 
(latest) 

Win 7 yes n/a yes yes 

Win 8.1 yes n/a yes yes 

Win10 yes yes yes yes 

Mac OS (10.10 version) under 
Parallels with Windows 7, 8.1 and 

10 versions 
yes 

Yes  
(on Win 
10 only) 

yes yes 

Mac OS (10.11 version) under 
Parallels with Windows 7, 8.1 and 

10 versions 
yes 

Yes  
(on Win 
10 only) 

yes yes 

 Software Requirements 
• Read / Write access to the C:\Program Files\Align folder and ALL subfolders 

• Activated SSL 3 

• Protection hardware/software must be configured accordingly to allow the Invisalign 
Doctor Site to send / receive data (allow port 80 for http and port 443 to https for in-
bound and outbound) 

• No toolbars – or need to be configured accordingly 

• Cookies enabled for Internet Explorer 

• Third-Party Plugins/Add-ons allowed in Internet Explorer 

• Ensure you install the latest graphics drivers 

• You must have administrative rights on your computer. 

 Administrator Requirements 
• Before beginning installation, ensure that you have Administrator rights on your com-

puter. On your desktop, right-click My Computer, and then select Manage. 

• In the left pane, expand System Tools, and then click Local Users and Groups. In the 
right pane, double-click Groups. 

• Double-click Administrators. If your name appears in Members you have Administra-
tor rights. 

• If you do not have Administrator rights, have your Administrator assign you Adminis-
trator rights. 



ClinCheck® Pro 5.0 User’s Guide 

Part No. D16765 Page 69 

 Adobe Acrobat Reader Version 9 Requirements 
• Open a browser window and go to http: http://adobe.com/reader/  

• Download Acrobat Reader Version 9 (or higher) from this website. 

 Pop-up Blocker Requirements 

The ClinCheck Pro software relies on several pop-up windows to function. If you have 
pop-up blocking software installed it may prevent ClinCheck Pro software and other VIP 
tools from operating correctly. Many pop-up blockers are available commercially. These 
pop-up blockers can be configured to allow pop-ups from specific websites. Consult the 
pop-up blocking software help files for more information on how to configure this feature. 
Usually you will need to indicate a root URL in your configuration to allow pop-ups from 
specific web sites. Use the following values to configure the ClinCheck Pro software: 

• http://*.aligntech.com 

• http://*.invisalign.com 

As an alternative to configuring your pop-up blocking software, you may choose to turn 
off any pop-up blocker when using ClinCheck Pro software to avoid a conflict. 

The ClinCheck software is designed to work with the default security settings for 
Microsoft Internet Explorer. If your browser security settings have been changed you 
may not be able to access the ClinCheck software. Follow the steps below to check your 
settings and return the security settings to their default level: 

• Open Microsoft Internet Explorer. 

• From the Tools menu select Internet Options. 

• Select the Security tab. 

• Select Trusted Sites. 

• Click the Sites button. 

• Click inside Add these URLs to the zone. 

• Type these URLs (click Add after each one): 
o https://*.invisalign.com 
o https://*.aligntech.com  

• Click Close. 

• Click OK. 

• Close Microsoft Internet Explorer. 

http://adobe.com/
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 Anti-Virus Software Requirements 

You must configure your anti-virus software if it is installed in your computer to allow the 
ClinCheck software to communicate with the servers running the Invisalign service. For 
information about configuring your anti-virus software, ask your computer support 
technician or contact Align Customer Care. You can find information about Align 
Customer Care on the Support page on the Invisalign Doctor Site. 

 Graphics Driver Requirements 

The ClinCheck software displays 3D models that require up-to-date graphics drivers. To 
obtain help installing the graphics driver software, ask your computer support technician 
or contact Align Customer Care. You can find information about Align Customer Care on 
the Support page on the Invisalign Doctor Site. 

23. Installation Procedure 

 Downloading the Software 

Log in to the Invisalign Doctor Site. 

• Click the Support tab. 

• Click the Software download link and download the ClinCheck software. 

• Follow the on-screen instructions and begin using the ClinCheck software. 

 Installing ClinCheck Software on the Network 

You can set up a single Invisalign Patients Viewer for access by multiple computers and 
users on a network. By default, an Invisalign Patients Viewer is installed on each local 
machine where the ClinCheck software is installed. You must install the ClinCheck 
software on each computer in the network; however, all those computers will have the 
ability to share a common, centralized Invisalign Patients Viewer. 

• Share the Invisalign Patent Viewer using the following procedure: 
o From your Start menu, select My Computer. 
o Go to C:\Program Files\Align. This is the default location. 
o Right click the Invisalign Patients folder icon and select Properties. 
o Click the Sharing tab, and select Share This Folder. By default, the share name 

is Invisalign Patients. 

• Select the Security tab. 
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• Click Add, and then add the Windows user accounts of all individuals who need ac-
cess to the Invisalign Patients Viewer. 

• Click OK. 

• For each Windows user you have added, highlight the users name, then click the 
Permissions box in the Allow column to assign privileges for the user. 

• When you are finished with all users, click Apply. 

To find the share name and computer where you installed the Invisalign Patients Viewer: 

• In Windows, right click the My Computer icon (or go to the Start menu and select My 
Computer) and select Properties. 

• Select the Computer Name tab. The full computer name is displayed here. 

• Write down the computer name. You will need this name for the next step. 

• Click OK. 

• Install the ClinCheck software on all computers that need access to the Invisalign 
Patients Viewer. 

• Use the installation instructions to install the ClinCheck software on each computer in 
your network. The Installation Wizard displays. Follow the onscreen instructions. 

• In the Choose Destination Location dialog, click Browse, then enter the Network Path 
of the Invisalign Patients Viewer you previously installed. 

• Enter the path as \\COMPUTERNAME\SHARENAME, where COMPUTER NAME is 
the name of your computer and the SHARE NAME is Invisalign Patients. 

• Click the Next button and continue with the installation. 

24. Symbol Definitions 

 
Manufacturer 

 
Authorized Representative in the European Community 

Rx Only CAUTION: US Federal Law restricts this device to sale by or on the 
order of a licensed Dentist, Orthodontist, or Dental Professional. 

 

file://COMPUTERNAME/SHARENAME
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